
Presentation Quick Start

First Steps with Presentation / Marvis App
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Introduction
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Using the Presentation application (also called Marvis), you can display and 
analyze measured curves, spectra and other results. You generate reports which 
can be printed or exported.
Presentation can load data for many measurements, so you can compare 
measurements and evaluate differences.
You can load measurements from the result data base, or directly from archive 
files which store the measured data.

Installing and Updating Presentation
The Presentation App is 64 Bit software and can be installed on any Windows PC 
running Windows 10 or upwards, even without administrative rights if necessary.

You can download installation and update packages for Presentation 
from our web server at
download.discom.de/Presentation
You will also find installation instructions and manuals there.

If your company has obtained TAS boxes and measurement PCs from Discom, you automatically have a site 
license for the Discom evaluation software tools (Presentation, WebPalViewer, TasWavEditor). You do not 
need to get a separate license for installation of these applications on any company PC.

http://www.discom.de/download/Presentation
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Presentation Projects
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The Microsoft Word application works on a Word document, Excel on a spreadsheet. 
Similarly, Presentation works on a Project.
A Presentation project consists of a collection of page descriptions with project-specific 
layout, a collection of macros for displaying data (called Rapports), settings, and other 
items specific for a project, like customer logos. All according files are collected in a folder, 
called the project folder.

The Project Base File is also located in the project folder. When you want to load a project, 
you open the base file with Presentation. The file extension of Presentation project base 
files is bse; in most cases the base file will have the name Base.bse.

Project Name

Presentation Base File

When you have freshly installed Presentation on a computer and start it for the first time, 
it will ask for the project base file. You can copy the project folder from a measurement 
PC and store it at any location on your PC. Then, direct Presentation to that folder to 
open the base file.
On measurement PCs, the Presentation projects are normally located in folder
C:\Discom\Analysis\Presentations\
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Basic Terms
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Layout Pages:
The layouts are printable report pages. 
Their content can be adapted to your 
requirements.

Graphics Modules:
There are curve plots, text boxes, pictures, lists 
and more.
Double-click on a graphics module to call up and 
change its settings (e.g., to change the scaling of 
a graph or the content of a text box).

Control Window:
In this window you can see the list of 
loaded measurements and can control 
the display.

Menu and 
Toolbars:
With these buttons 
you quickly call up 
different functions.

The major elements of Presentation user interface are:
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Standard Workflow
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When using Presentation, the typical workflow is
1. Load measurements
2. Display data with Rapports
3. Adjust display settings
4. Work with the list of loaded measurements
5. Un-load all measurements and load new ones.
There are many more things that can be done in Presentation, 
but these are the basic steps you will always need, and which 
are explained in the documentation.

Each measurement contains many 
different data, like spectra, order tracks, 
single values, spectrograms and more. 
“Display Data” means to decide which 
data you want to see and get them drawn 
in graphics modules on layout pages.
“Rapports” generate pre-defined reports.

A note about saving: 
When you close Presentation app, all changes you made to graphics, layouts, display 
settings and so on are automatically saved. (Go to menu Project – Read-only settings
to activate write protection for different categories.)
You can have multiple instances of Presentation running at the same time, using the 
same project. When you close these multiple instances one after the other, the last 
one wins with respect to saving settings!

Project Folder
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Loading Measurements
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You can open archive files directly in Presentation by double-clicking on the rdt file, 
or by dragging an archive file from Windows explorer into an open Presentation.
If you are connected to a result database server, use toolbar buttons (1) or (2) or 
key F5 to open the database assistant and get measurements from the database. 
(Loading measurements from database is explained in more detail later.) 

Press toolbar button (1) to un-load all measurements and empty the list. 
Then, load new measurements from file or data base.

4

13

4

1

With button (3) or key F2 you open the control window where the list of loaded 
measurements is shown (see next page).

3

2

2 ?

Button  V   will show software version information for the installed Presentation 
and direct you to the software download website.

?
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The Control Window
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The Control Window has seven tabs for different purposes. 
The tabs you will use most are List, Data and Groups:

The List tab shows all currently 
loaded measurements. See next 
page for more details on the List tab.

The Data tab holds the Contents Tree 
which sorts all data contained in the 
loaded measurements.
From here, you can assign data 
nodes to graphics modules (e.g.
spectra to a plot) to get them 
displayed.

Measurements can be placed in groups to be able to 
compare batches of results. In the Groups tab, you can 
define groups, change their names and colors and their 
sorting order (which influences the display order).
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The List of Measurements
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The List tab helps to organize the loaded measurements and highlight certain 
measurements in the data display:

This measurement has the Focus. 
Only one measurement can have 
the focus. Select a measurement 
and press        to set the focus. 

These measurements are marked. 
You can mark any number of 
measurements. Select a measure-
ment and press        to mark it. 
Press        to remove all marks.

This is the selected measurement. 
Select measurements as you 
would do in any Windows 
application. Some functions (like 
marking) apply to all selected 
measurements.

Curves of the focus measurement 
are drawn in blue, marked
measurements are shown in green. 

Press button        to select which columns appear in the list. 

Right-click on a selected 
measurement to call up a 
menu with functions for all 
selected measurements.

“Hide items” will remove all 
selected measurements from the 
list and all data displays, “un-hide” 
will bring them back. 
“Remove from list” will completely 
un-load these measurements.

Double-click in the list repeats the last operation. If you have set the focus 
immediately before, double-click will move the focus to the selected list 
item. If you have marked measurements before, double-click will mark 
additional measurements.
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Querying the Result Database
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Press toolbar button Q or key F5 to load measurements from the result data base:

Set up your selection 
criteria here: time 
range, type, test bench 
and so on.

The list shows all 
measurements matching your 
selection criteria.
When a large number of measurements 
match the criteria, the list is not immediately 
filled, but you get a message in the list 
header.

1

2If you want to load 
only some of the 
measurements from 
the list, set check 
marks in front of 
these.
(No check marks = all 
measurements will 
be loaded.)

Enter part of a serial number and set the check 
mark to filter for measurements according to 
this serial number.

Choose a display macro and press 
[Display Measurements]

or press [Expert Mode].

3

Additional selection criteria 
can be defined here.
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Simple Database Query
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GaussData

If you simply want to load the latest 20 measurements from the result database 
without advanced filter options, you can use the Simple Database Query function:

Select how many measurements you want to load:
1, 5, 20, 50 or 100
You can simply use the type of the most recent 
measurement or select a specific type and test bench.
Here you can see the information about the most recent 
measurement (so you know which type you get).

Measurements are loaded and added 
to the existing list of measurements.

You can have measurements loaded from archive files and from the database 
simultaneously in your List.
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Displaying Data with Rapports
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A “Rapport” is similar to a macro or simple program. It brings certain data onto certain 
layout pages (for example, all order spectra for one test step onto a page with six 
curve plots).
To use a Rapport, simply select it from the list at the right end of the toolbar and press 
the Start      button:

Use this selection list to open 
any layout page.

Rapport selection list

Many Rapports will ask for parameters when started 
(like the test step to be displayed).
Make your choices and press [OK].

Layout pages are opened 
and filled with data.

Rapports are project specific. Typically, a project will 
contain Rapports for the most common analysis tasks.
You can ask Discom to add or modify Rapports or do it 
yourself. (Please refer to the separate documentation.)
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Displaying Data Manually
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If you want to display specific data which are not covered by a Rapport, 
you can place them manually onto a Layout page.

1. Open the Data tab in the Control window.

2. Unfold the Contents tree and select the node 
which represents the data you want to display.

3. Press button [Show ‘X’ in..]

The ‘Graphics modules’ tree represents all layout 
pages and all graphics modules within.

4. Select the graphics module you want to use for 
displaying your data and either double-click or 
press button

5. Press [Apply] or [OK].

6. Press button [Display ‘X’]

Open the according layout page to see 
the graphics.

For updating the display, you only need 
to press the [Display ‘X’] button again.

2

1

4

5

Manual graphics assignments are released when your start a Rapport.

You can display the 
same data node in 
multiple graphics 
modules.

3
6
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Some Useful Buttons

22-07-18 13

Buttons in the toolbar of Presentation app:

Open Control window

Remove all loaded 
measurements 
(empty the List)

Print active / all 
layout pages

Show version info

Close all layout pages

Toggle display of 
limits: all / final / off

Start selected Rapport

There are three states for displaying limit curves:
• Show the limit curves for all loaded measurements, 
• Show only the limit curve of the last measurement,
• Show no limit curves.
This button toggles between the three options.
Values (curves) for which limit evaluation is switched 
off in parameter database do not have limit curves.

Connection to result database 
and associated archive search 
path are specified here.

You can change the user interface language for Presentation here.

If you are using more than one monitor connected to your 
computer, you might want to switch off the “use only main 
monitor” option.
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Working with Curve Plots
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In general, double-click on any graphic module will call up the settings for that module. 
Curve plot modules have very large set of display parameters, including the scaling settings.

The first section is ‘Scaling’, where you 
can adjust the x and y axes.
The chain symbol        shows that the 
scaling is linked to another plot module.

Go to ‘Attach Scaling’ 
to connect the scaling 
settings of one plot to 
another. 

A plot module can show an automatic 
title in a text box module. Go to the 
‘Caption’ section to activate this 
function and select the text box.

Bring a layout window to foreground and place the mouse cursor inside a plot module. Then you can use the 
keyboard arrow buttons or the mouse wheel to scroll through the data. Use Shift + mouse wheel for x axis 
scrolling and Ctrl + mouse wheel for scaling zoom.
(If you have attached the scaling of a plot to another plot, you have to use the function on that other plot.)
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Working with Layout Pages
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Open the settings for a layout page by double-clicking somewhere 
outside of all graphic modules. 

Edit Mode
If you want to change the layout 
page content itself (move or resize 
graphic modules, add new ones, 
etc.), you have to switch on Edit 
Mode. This will disable some 
functions like scrolling in plots 
with the mouse wheel, so make 
sure to switch off Edit Mode after 
you are finished.

In ‘Layout View’ tab, you can set the 
zoom factor for page display. ‘auto’ will 
scale the page to fit into the window.
You can also activate Edit Mode here.

In ‘Colours and Lines’, you can change the 
global colour table and the line widths which 
are used in plots for the different colors.
The colour table is global for the project, so 
you can change it in any layout page and it will 
apply for all pages.

In ‘Page’ you select the paper format 
and orientation to use for your page.
If the layout content does not fit within 
a standard paper for printing, use the 
Scaling option to make it fit.
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Exporting Graphics
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Instead of taking screenshots from Presentation app displays, you can 
directly export the graphics in high resolution.

Right-click into any graphic, open the “Export” 
sub-menu and choose either “Save to file” or 
“To clipboard”.

Convenient shortcut:
Shift + right-click into a graphic to 
directly copy it to the clipboard. 

The graphic can be exported either as picture (in png format) or as 
drawing (wmf format). 
If you plan to paste the graphics into a PowerPoint presentation, email 
or other document, png format is the most suited format.
Vector graphics are scalable to very large dimensions but can consume 
a lot of memory and will not convert properly to pdf.
Open the page settings of any page (double-click into an empty part of 
the page) and go to the Colours and Lines tab to select the graphics 
export format.
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Exporting Data for Excel
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Load the measurements from which you want to export data into Presentation.
If you want to export single values, you can proceed directly. 
If you want to export curve data, you may have to display the curves in order to load 
the data into memory.
Open the Control window, switch to the “Data” tab and expand the Contents tree:

Right-click onto the node you want to export. 
You can select a base node like “Spectra” or 
“Single Values”, or a sub-node. 
From the context menu, choose the command 
“Excel Export…”

The export result is a text file of type html which can 
be viewed with a web browser. 
Right-click on the file and choose “Open with – Excel” 
from the Windows Explorer context menu, or open 
the file directly with Excel.

Read the dedicated manual for Excel Export from Presentation (see page 21) for 
more details and additional options.
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Selecting Curves with the Mouse
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Display curves in a plot. Hold the Shift key and left mouse button, then drag a rectangle 
inside the plot. All curves passing through that rectangle will be marked (see page 8), 
all others un-marked.

If curves in the rectangle do not get marked, try re-displaying the curves or re-running the Rapport.

In the list of measurements, you can use further 
operations on the marked measurements by right-
clicking on a row and calling up the popup menu.
Perform a new, empty selection or use button       
above the list to un-mark all items.
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Using Groups
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By sorting measurements into groups, you can compare different batches of test runs. 

In the list of measurements, select one 
or more rows and right-click on one of 
the selected measurements.
Open the sub-menu Group and choose a 
group. The measurements will be placed 
in that group.

Go to the Groups tab in the control window 
to change your groups.
Double-click on a group row to change the 
name and colors. Press button [New…] to 
create a new group.

Use these buttons to change the 
group order. Measurements in 
groups at the bottom are 
plotted last = in the foreground.

Select a group in the list and press 
this button to hide all measurements 
in this group. Press it again to make 
them visible.

The number in brackets shows 
how many measurements are 
in that group.

See page 8 on how to get the Group as a list column.
Click into a column head to sort by that column.
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What if I messed up?
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As explained on page 5, Presentation automatically saves all changes when you close it.
If you messed up something, e.g. inadvertently moved or deleted graphic modules, use the 
Emergency Exit command in File menu:

Go to menu Project – Read-Only Settings to write-protect 
some aspects, e.g. window positions or layout page content.
You still can change things while Presentation is open, but 
the changes will not be saved.

See page 3 on information about the project folder. Simply copy that folder to create 
a project backup. 
If you want to restore that backup, just replace the project folder with the copy.
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Where can I learn more?
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Visit https://download.discom.de/Presentation and scroll down to the Manuals section. 
There you can find several short manuals about different topics.

If you cannot find the information you are looking for, reach out to Discom, 
and we will be happy to help you.

https://download.discom.de/Presentation
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